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 Introd uction
1.  Knowing Enough to be Dangerous!

Please note that this workshop is intended to give you a working knowledge of GPS to
the degree that you can collect data for use in natural resources inventories and
planning.  This workshop does not give you the skills or authority of a licensed land
surveyor.  Applications of GPS for recording property boundaries, zoning boundaries
and other legal boundaries such as setbacks requires the involvement of a licensed land
surveyor.  Likewise, legally binding calculations of property area must also be performed
by licensed surveyors. See the Appendix for the legal definition of land surveying and
the restrictions on practicing surveying.

2.  Policy for Borrowing GPS Unit
The Trimble Pathfinder Pro XR GPS units are available for non-profit projects.
Individuals who have completed a UNH Cooperative Extension’s GPS educational
workshop may borrow them.  Borrowing the units for purposes other than non-profit
projects requires special permission.  Without exception, the units must be returned on
time and with all items present and in excellent condition.  Damage to the units or any
parts must be reported immediately.  Failure to abide by this policy will result in the loss
of borrowing privileges. To borrow a GPS unit, please contact Sharon Hughes (ph:
(603)862-1029, email: sharon.hughes@unh.edu).

3.  Checklist of Items included with the GPS

Please make sure all items are returned in excellent condition.

Equipment Provided
 Trimble carrying case (black plastic)
 Data logger with nylon case
 Antenna with nylon case
 Antenna poles (2 – 1 long, 1 short)
 Nylon backpack containing

 Pro XRS receiver (w/ nylon case)
 Batteries (4)
 Dual battery cable (batteries to receiver – port B)
 Antenna cable (antenna port to antenna)
 Data/Power cable (receiver – port B to data logger cable)
 Data cable (Data power cable to TSC1 or TSC1 to download)

 Spare  Double female cable (black)
 Battery charger – yellow (aka Trimble Support Unit)
 Power pack cable ( 120v to support unit)
 Extension cable – yellow (battery charger to TSC1 Data/Power cable)
 NMEA/RTCM cable (double headed)
 CD – Pathfinder Office
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Please note that the following optional items are only included if you request them
specifically.

Optional Manuals
Manuals:
 TSC1 Asset Surveyor – Operation Manual
 TSC1 Asset Surveyor – Software User Guide
 Pro XR/XRS Receiver Manual
 GPS Pathfinder Office – Getting Started Guide
 Mapping Systems – General Reference

Individuals loading GPS Pathfinder Office software are required to remove the software
when they return the GPS units.  Failure to remove the software jeopardizes the GPS
loan program.

4.  Places to go for Additional Information

GPS Education
• List of GPS Resources: http://gpshome.ssc.nasa.gov/content.aspx?s=res

• DNR Garmin – freeware that allows you to export data from a Garmin into an
ArcView Shapefile:
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRG
armin.html.

• USA PhotoMaps – freeware that downloads data from a handheld GPS onto a
topographic map or aerial photo that the software retrieves from the web.
Available at: http://www.jdmcox.com/

• GPS tutorial: http://www.trimble.com/gps/index.htm

• The Geographer’s Craft Project:
http://www.colorado.Edu/geography/gcraft/notes/gps/gps_f.html

• GPS Resource Library: http://www.gpsy.com/gpsinfo/

• GPS World Magazine: http://www.gpsworld.com/

• Variety of helpful information related to GPS: http://gpsinformation.net/

• Geocaching – a GPS sport: http://www.geocaching.com/

Geodesy and Other Related Topics

• Coordinate system overview:
http://www.ncgia.ucsb.edu/education/curricula/giscc/units/u013/u013.html

• Map and compass training: http://www.nwcg.gov/pms/training/map_comp.pdf

• Survey and Land Glossary: http://www.or.blm.gov/NILS/welcome.htm
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• The Geodetic Tool Kit, available at http://www.ngs.noaa.gov/TOOLS/ /, includes
software that converts coordinates, transforms datums, and more.

• Corpscon, available at http://crunch.tec.army.mil/software/corpscon/corpscon.html,
is a MS-Windows-based program which allows the user to convert coordinates
between Geographic, State Plane and UTM systems on NAD 27, NAD83 and the
High Accuracy Reference Networks (HARNs).

5.  GPS Manufacturers
A list of GPS manufacturers can be found in the Appendix.
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 The B asics
1.  Process Overview

Below is an overview of the process for collecting GPS data described in this manual:

1. Mission plan: Determine best times to collect GPS data (Exercise 1).
2. Data dictionary: Create a data dictionary (Exercise 2) or import one from a GIS

attribute table (Exercise 5) and download onto the data logger.
3. Preparation for field work (The Basics chapter):

Assemble GPS unit.
Check and charge data logger and GPS receiver batteries.
Check data logger storage space. Delete files if necessary.
Configure critical settings.

4. Data collection (Exercise 3).
5. Post-process data – apply differential corrections (Exercise 4).
6. Export data to GIS files (Exercise 4).

2.  Data logger
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3.  Data Logger Menus



The Basics

UNH Cooperative Extension 7

4.  Battery checking and charging
a) Turn on the data logger.  The battery icon will be visible at the bottom left of the

screen.  If the data logger is connected to the GPS receiver, this icon shows the
battery charge of the GPS receiver batteries.  If the data logger is connected to the
computer, then this icon shows the charge of the data logger battery.

b) To more precisely determine the internal and external battery charge level, connect
the data logger to the GPS receiver (see step 6).  Select Configuration from the
main menu and press <Enter>.

c) Select Hardware (TSC1) and press <Enter>.

d) You can now read the external (receiver) and internal (data logger) battery levels.

TIP: You can generally expect six hours of operation from a set of fully charged
batteries.  Expect less operational time (three hours or less) from batteries when
operating in cold weather.
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5.  Battery charging – GPS Receiver Batteries
a) Locate the battery charger (TSM-yellow charging unit with four battery bays) and the

AC Adapter.

b) Plug the AC Adapter into the battery charger port labeled POWER IN.  Push firmly
until you feel the plug click into place.  (To remove, push down on the black release
button and pull.)

c) Plug the other end of the AC Adapter into a wall socket.

d) To charge the receiver batteries, remove all the batteries requiring charging from the
backpack unit, unclipping the pair of batteries currently connected to the receiver.

e) Place the batteries into the battery charger, being careful to match the metal
contacts on the battery with those on the battery charger.

NOTE:  The battery charger will assess the charge level of all the batteries which have
been inserted and begin charging the lowest battery first.  A blinking yellow light
indicates that the battery is being charged.  A solid yellow light indicates that the battery
is waiting to be charged.  The battery is fully charged when the light turns green.

TIP: A red light indicates problems.  Check that the battery is correctly inserted into the
battery charger.

NOTE: Do not expect batteries to show 100% charge after charging.  They generally
cannot achieve 100% capacity.

6.  Battery charging – Data Logger Batteries
a) Connect the battery charger and the AC Adapter as described in steps 4a-4c.

b) Locate the download/charging cables in the zip
lock bag.

c) Disconnect the two cables and plug the “male”
end of the coiled data logger cable (labeled
yellow) into the battery charger port labeled
DATA LOGGER (labeled yellow).

d) Plug the other end of the data logger cable
(labeled green) into the bottom data logger port.

TIP:  During charging, the data logger battery level
can be assessed by going to the Hardware (TSC1)
option in the Configuration menu.
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NOTE: Do not expect batteries to show 100% charge after charging.  They cannot
always achieve 100% capacity

7.  Connecting the data logger to the GPS receiver and antenna

a) Open the backpack and locate the
coiled data logger cable.  This cable
should be attached to Port B of the
receiver.  Do not detach this cable.

b) There are two ports (labeled green)
on the data logger where the data
cable may be inserted.  Choose the
port that does not stress the cable.
For example, if you will be laying the
logger onto a surface, choose the
bottom port.  If you will be holding the
bottom of the data logger against
you, choose the top port.

c) Expose the port on the data logger by
pulling out the black rubber plug, and
insert the data cable connector
(labeled green) into the data logger
port, being careful to match the
raised metal slide on the cable with
the slot in the data logger connector.

IMPORTANT: To disconnect the data
logger cable, pull back on the thin metal
cable attached to the connector as you
are pulling on the connector.

d) Locate and connect the two yellow antenna poles (one short, one long).

e) Screw the antenna to one end of assembled poles and connect the other end of the
antenna/antenna pole assembly to the backpack.

f) Locate the antenna cable in the backpack (labeled red).  Check that this cable is
attached to the receiver port labeled ANT.  Do not detach this cable.

g) Connect the screw-on cable connector to the port located on the underside of the
antenna (labeled red).

TIP: Make sure that the cable is correctly screwed into the antenna.  If you don’t have a
good connection between the antenna and the cable, the GPS receiver won’t pick up
satellite signals.
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8.  Connecting the data logger to the computer
a) Locate the download/charging cables

(in the zip lock bag).

b) There are two ports (labeled green)
on the data logger where the data
cable may be inserted.  Choose the
port that does not stress the cable.  In
this case you will be laying the data
logger onto a table surface, so plug
the coiled data logger cable (labeled
green) into the bottom data logger.

c) Connect the pink end of the data logger cable to the pink end of the double-ended
connector cable.

d) Plug the “female” end of the cable into the computer.  (Select the “male” port on your
computer that matches the size and shape of the “female” connector.)

e) When you are finished with these cables, please return them to the zip lock bag.

9.  Deleting Files
a) From the main menu of the data logger,

select File Manager.

b) Select delete file(s).

c) Select the file you want to delete and
press <Enter>.

d) Select F1 to confirm the deletion or F5 to
cancel.

TIP: To delete all the files in the list, press F5 from the delete files menu.

NOTE:  If you try to delete a file that has not yet been downloaded from the data logger,
you will receive a warning that the file has not been downloaded.
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 Exerc ise 1: Mission Planning
Mission planning requires that you consider what information you need to collect and the
best time and place to collect it.  Pathfinder Office includes a Quick Plan utility that helps
you determine the best data collection times based on satellite availability.  We highly
recommend that you complete a mission plan in order to use your time out in the field
more efficiently.

TIP: You can download free Quick Plan software and satellite ephemeris data from
Trimble’s web site to create a mission plan.  This software and data will allow you to
create a mission plan even if you don’t own Pathfinder Office software.  For Quick Plan
software go to ftp://ftp.trimble.com/pub/survey/gpsurvey and download the file
qkp235.exe.  For the current almanac, go to
http://www.trimble.com/gpsdataresources.html and click on Current Ephermeris Data
to download the file.

1.  Start a New Project
a) Start Pathfinder Office software.

NOTE:  If this is the first time Pathfinder Office is used since it was installed, it will ask
you for Time Zone settings.  See step 3 below for information on setting New
Hampshire’s time zones.

b) Start a new project by clicking
on the New button.
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c) Type in GPSWorkshop as the
Project Name.

d) Click on the Project Folder
box.  If it doesn’t appear
automatically, type in:
c:\Pfdata\GPSWorkshop

e) Click on OK.

NOTE:  Pathfinder Office software helps you to stay organized by creating folders for
you.  In this step we have created the following folders:

C:\Pfdata\GPSWorkshop\backup – Pathfinder Office will automatically back up data
files to this folder.
C:\Pfdata\GPSWorkshop\export – Files you export from Pathinder Office are
automatically placed in this folder.
C:\Pfdata\GPSWorkshop\base – Base station files you download from the internet to
correct your data are automatically placed in this folder.

TIP:  Use the Pfdata folder for all of your Pathfinder Office projects, and you will always
know where to find your GPS data.  Create different project folders within the Pfdata to
separate your various projects.

f) Use My Computer or Windows Explorer to find the project folders you just created.
Pathfinder Office will place your data into these folders.

2.  Download Almanac
The almanac is a set of data that are used to predict satellite orbits over a period of
about a month.  Pathfinder Office requires an almanac that is no more than 30 days old
to produce accurate results because satellite orbits change, new satellites are launched
and old satellites may cease to function adequately. If you haven’t downloaded an
almanac within the last 30 days, the software will warn you that the almanac is out of
date, and you will need to download an almanac file from the Data Logger or from
Trimble’s web site. Following is information on downloading the almanac from the Data
logger; see Tip at beginning of exercise for information on downloading the almanac
information from Trimble’s web site.

The GPS receiver will automatically download an almanac from the satellites when it is
in use.  You need to have the GPS receiver logging this satellite information for about 15
minutes to update the almanac. You can then download the almanac from the GPS data
logger to your computer. These directions assume that you have already collected an
updated almanac.
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a) Connect the Data Logger to your computer.

TIP:  When your Data Logger software boots up, it
automatically will try to connect to GPS satellites.  It
will say, “Connecting to GPS” in the lower right
corner of the data logger screen.  Press the <Esc> button on the Data Logger, and it will
eventually stop trying to connect to the GPS receiver.

b) From the GPS Data Logger Main Menu, select File
Manager.

c) Select File Transfer.

d) Leave the data logger on the screen that says,
“Connect cable to PC”.

e) Return to the Pathfinder Office software on your computer.

f) From the Utilities menu,
select Data Transfer.

g) Click the Receive tab.

h) Click the Add button.

i) Select Almanac from
the list of file types you
can download.
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j) Accept the default path and
filename that Pathfinder Office
assigns to the almanac file by
clicking on OK.

k) Click on Transfer All.

l) If there is already an
almanac file on your
computer, it will ask you if
you would like to
overwrite that file.  Click
on Yes.

m) Close the Transfer completed notice
window.

n) Click on Close to close the Data Transfer
window.

TIP:  Make sure your close the Data Transfer window when you are finished transferring
so that you don’t inadvertently open a second Data Transfer later in your session.  If you
have more than one Data Transfer window open at the same time, you may have
problems transferring the data.

3.  Check Time Settings
In order to get a correct mission plan, the time settings in Pathfinder Office need to be
correct.  NH will be on Eastern Standard or Eastern Daylight time as noted below:

1st Sunday in April – last Saturday in October – Eastern Daylight Savings Time
Last Sunday in October – 1st Saturday in April – Eastern Standard Time
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Quick
Plan

a) To check the time setting in
Pathfinder Office, from the Options
menu, select Time Zone.

b) Select Eastern Day or Eastern Std,
depending on the time of year.

4.  Generate Quick Plan
a) Click on the Quick Plan button or from the Utilities

menu, select Quick Plan.

b) Select the date that you will
be collecting data.

c) Click on OK.
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d) There are several ways to select a
position on which the Quick Plan will be
based.  An easy way to identify the
position is to click on Cities.

e) Select Concord, NH from the list.

f) Click on OK.

NOTE:  The Quick Plan is good within about a
300 mile radius of the position you select.  If your
intended field collection location is not within a
300 mile radius of the points listed here, you can
designate a different point by using the keyboard
option.  See optional exercise below.

g) From the Graphs menu, select Number SVs
and PDOP.

QUESTION: Which times of the day would be the best for your mission?  Which times
should you avoid?
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NOTE: Note that although the PDOP values are closely related to the number of
satellites available, other factors such as the positions of the satellites relative to one
another also affect the PDOP.

TIP: Be aware that the PDOP values in the graphs produced by the Quick Plan assume
optimum conditions and represent a best-case scenario.  Forest canopies and other
obstacles that can block satellite signals will increase the PDOP values thereby
degrading the accuracy.

5.  OPTIONAL: Skyplot
Generate a skyplot to see the satellite paths.  This information can help you to more
efficiently collect data.

a) Make sure the Quick Plan utility is active.  If it is not, select Quick Plan from the
Utility menu.

b) From the Graphs menu, select Skyplot.

c) To interpret the resulting graph, imagine laying on your back with your head pointing
north.  Hold the graph above you with the top facing north.  The lines show the orbits
of the satellites.  The important thing to note is that the satellites do not go over the
north pole.  Although it is not obvious from the skyplot, the satellites don’t go over
the south pole either.  (Don’t worry, you can still get excellent GPS positions during
your next visit to the north and south poles.)  There are a couple of implications to
these orbital patterns when collecting data. If you are collecting data with a handheld
GPS unit, position your body to the north in order to block fewer satellites.  Similarly,
if you are mapping the position of an object such as a tree, place the GPS antennae
on the south side of the object so that the object blocks fewer satellites.



GPS Manual

18 UNH Cooperative Extension

6.  OPTIONAL: Keyboard Entry
You can input a location using the Keyboard option.

a) Make sure the Quick Plan utility is active.  If it is not,
select Quick Plan from the Utility menu.

b) From the Session menu, select Edit Session.

TIP: If Edit Session is not available, select New Session
and continue from step v.

c) Click on the Edit button.

d) Click on Create>>.

e) Click on Keyboard.
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f) Change the station name to
Durham.

g) Change the latitude to: 43 degrees,
7 minutes, 30 seconds.

h) Make sure that N (for northern
hemisphere) is selected for latitude.

i) Change the longitude to: 70
degrees, 52 minutes, 30 seconds.

j) Make sure that W (for western hemisphere) is selected for longitude.

k) Click on OK.

TIP:  If you see this error message
indicating that the Time Zone and
Longitude aren’t consistent, then
you may not have correctly set the
hemispheres in step h and j.

l) Select Durham from the list of all points and
click on Add.

m) Click on OK.

n) The graph, if open, will automatically update
itself.  If the graph is not open, from the
Graphs menu, select Number Satellites.

NOTE:  There may not be any noticeable
differences between the graphs for the Concord
and Durham points because the locations are
relatively close together.  You many want to add
another point in the same time zone (e.g.,
Tampa, Florida) to see an appreciable
difference in the graph.

o) Close the Quick Plan window to return to
Pathfinder Office.

TIP:  To determine the latitude and
longitude for an area, read the
lower right corner of the USGS
topographic map that includes your
area of interest.  This latitude and
longitude information is accurate
enough for Quick Plan.  The
latitude and longitude for Durham
were selected from the corner of
the topographic map that includes
Durham (Dover West quad) as
shown here.

latitude

longitude
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7.  OPTIONAL: Auto-Time
Pathfinder Office will show you which times of the day will meet your data collection
criteria.
a) From the Options menu, select Auto Time.

b) Input your criteria for data collection.  Remember the lower the PDOP, the higher
quality your readings will be.  (Recommended PDOP <= 6)

c) Select the Number SV’s and PDOP graph from the Graphs menu, if it isn’t already
displayed.

d) Note that the optimal viewing times are now displayed on your graph.

8.  OPTIONAL: Edit Date and Time
a) From the Session menu, select Edit Session.

b) Generally the list of sessions will include only one
session. Click on the Edit button.
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c) You may now adjust the time, date and location of
your session by selecting the Date>> and Time>>
buttons.

TIP: If you know there are obstructions where you will
be collecting data, you can revise your mission plan so
that it does not include satellites blocked by the
obstruction. A "curtain" refers to objects that block the
satellite signals from the GPS receiver. Note in the
figure that you can define and edit a “curtain” during an
edit session.

d) Select the Time>> button to refine the graph to
show only the times that you are able to do your
field work.

e) If you input your start time and duration (how
long you will be out in the field), then Quick
Plan will automatically calculate the stop time
when you click on OK.  Likewise, if you input
the start time and the stop time, Quick Plan
will automatically calculate the duration.
Remember when inputting times that Quick
Plan uses a 24 hour clock (also known as
“military time”) so 4:00 pm should be inputted
at 16:00.

f) When you are finished recording your
information, click on OK.

g) Click on OK in the Edit session window, and the graph will automatically update
itself to the new parameters that you have set.  If there is no graph showing, from
the Graph menu, select Number SV’s and PDOP.
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 Exerc ise 2: Data Dictionary
Information for a database can be collected along with the GPS-derived positional
information by developing a data dictionary.  The data dictionary, in essence, is simply a
form that one fills out when collecting data.  You can control which features are collected
and what information about those features is recorded. Information about features is
referred to as “attributes.”  Using a data dictionary rather than a paper form saves time
and effort in transcribing from the paper form to your database and prevents
transcription errors.  You can also require that specific information be collected or
restrict data entry to certain parameters.  It is also often faster to record information
when using a data dictionary because it minimizes the use of data logger keys for data
input.  By using a data dictionary, you can also insure that the GPS attribute data will be
compatible with your GIS database.

1.  Scenario
Public works would like to inventory its assets and maintain a database with information
regarding the condition and maintenance requirements of these items. Below is a table
showing the features to be collected.  The attribute columns show what information
about those features will be collected.  You will create this data dictionary in class and
use it during the GPS data collection exercise.

Table 1
Feature Feature

Type
Attribute
Type

Attribute
Name

Attribute Values

Menu Type Deciduous
Evergreen

Menu Condition *Healthy
Unhealthy
Dead
(*Make default)

Date Date Visited Auto Generate on Creation

*field entry not permitted
Text Comments

Urban Trees Point

Number Height(feet) See Step 10

Menu Condition Grass
Natural (shrubs, etc.)
Cultivated (flowers, etc.)
Bare ground (maintenance
needed)

Date Date Visited

Landscaping Area

Text Comments

Pedestrian
Way

Line Menu Condition *Good
Repair
Replace
(*Make default)
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Data
Dictionary

Feature Feature
Type

Attribute
Type

Attribute
Name

Attribute Values

Menu Surface Type Asphalt
Concrete
Dirt “Cow Path”

Numeric Width (feet) Decimal Places: 1
Minimum: 0
Maximum: 20
Default: 5

Parking Lot Area Menu **Type

(**Make
required)

Permit required
Metered
Fee required
Visitor/Free

Sign Point Menu **Type

(**Make
required)

Traffic
Other

Menu Benches Yes
No

Bus Stop Point

Menu Shelter Yes
No

2.  Adding Menu-Type Attributes

a) Select the Data Dictionary Editor tool or click on Data
Dictionary Editor in the Utilities menu.
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b) Type in YourName-PublicWorks as the Name of the data dictionary.

c) Click on New Feature.

d) Name the feature Urban
Tree.

e) Select Point as the
Feature Classification.

f) Click on OK.

g) Click on the Default
Settings tab.

h) You can set the minimum
number of positions you want
collected for a point feature.
If the GPS operator collects
less than this number of
positions, the data logger will
warn the operator.

i) Keep the accuracy setting as
the default, Code. The
alternative, Carrier, is for
survey –grade GPS
receivers.

j) Note the logging interval default setting for this point is 5 seconds.  The logging
interval in your data dictionary will supercede the logging interval set on the GPS
data logger.  Read the note and tip below and then determine if you want to change
the logging interval setting.

NOTE:  The default logging interval is set at 5 seconds because many base stations log
at 5 second intervals.  If you choose a logging interval that is different than the logging
interval of your base station then the corrections to your data will result from
interpolations rather than from actual measurements.  For most natural resources
applications this interpolation will not introduce significant error.  You should be aware,
however, that to obtain the most accurate data, you would set the logging interval equal
to the base station logging interval.
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TIP: Most of the base stations you will access from the internet are registered with the
National Geodetic Survey’s CORS program.  The CORS web site shows the locations
and logging intervals of CORS base stations (http://www.ngs.noaa.gov/CORS/).  The
Appendix includes a map showing the locations and logging intervals of CORS sites in
the northeast. The map shows that Montpelier, Vermont CORS site logs at 1 second
intervals while the Brunswick, Maine site logs at 30 second intervals.  To be certain of
logging intervals for the data you download from the internet, however, it is best to
contact the specific CORS site operator directly.  Contact information for the CORS site
operators is available from the CORS web site.

k) Click on New Attribute.

l) Select Menu as the type of attribute.

m) Click on Add.

n) Enter Type as the attribute
name.

o) Select Normal as the Field Entry
option.

p) Click on New to select new
attribute values.
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q) Type in Deciduous as the new
attribute value.

TIP:  You can save space in your database by entering a Code Value to be exported to
the GIS database.  This allows GPS operators in the field to see the full attribute value
without having to know the individual codes.  When the data are exported, however, only
the codes will be exported, thereby saving database space.  If you use Code Values in a
data dictionary, all the attributes must have code values.

r) Click on Add.

s) Repeat step l and type in
Evergreen as the attribute value.

t) Click on Add.

u) Click on Close when you are
done entering attribute values.

v) Check that your new attribute,
Type, has two values assigned to
it, Deciduous and Evergreen.

w) Click on OK.

3.  Review skills: Add a Menu-Type Attribute

a) Repeat steps 2l-n to create a menu-type
attribute called Condition.

b) Repeat steps 2n-w and assign the
attribute values for Condition as Healthy,
Unhealthy and Dead.  Make Healthy the
default value as shown in the figure.

4.  Save
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a) From the File menu, select Save
As.

b) Save in the folder:
c:\PfData\GPSWorkshop

c) Save the file with the same
name that you gave the data
dictionary in step 2b.  (It should
default to this name.)  In this
case, you named the dictionary:

YourName-PublicWorks.ddf

5.  Add a Date-Type Attribute
a) When you’ve completed the Condition

attribute, create a new date type
attribute by selecting date.

b) Click on Add.

c) Name the attribute Date
Visited.

d) Select Auto Generate on
Creation to have the value of
this field assigned
automatically.

e) Select Month-Day-Year as
the Format.

f) Select Not Permitted as the Field Entry option to prevent field collection personnel
from changing the date.

g) Click on OK.
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6.  Add a Text-Type Attribute

a) Select  Text as the attribute type.

b) Click on Add.

c) Name the attribute Comment.

d) Assign a value of 40 characters
to the length of the attribute.

e) Click on OK.

f) Close the New Attribute Dialog
box.

7.  Copy and Edit Features
Rather than starting from scratch to create the Landscaping feature, we will copy the
Urban Tree feature and edit it.

a) Select the Urban Tree
feature.  It should appear
highlighted if it is selected.

b) From the Edit menu, select
Copy Feature.

c) From the Edit menu, select
Paste Feature.

d) Select the second Urban
Feature in the list of
features.

e) Click on the Edit Feature
button.
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f) Change the feature name to
Landscaping.

g) Change the feature type to
Area.

h) Click on OK.

i) Note that the symbol associated with the
Landscaping feature has changed to a
polygon (area) type feature while the
Urban Tree has a point symbol.

8.  Edit Attribute Values
Note in the Table (at the beginning of this exercise) that describes the data dictionary
that the Condition attribute has different values for Landscaping features than it does for
Urban Features.  In this step, we will edit attribute values in a similar way that we edited
features in the previous step.

a) Select the Landscaping feature.

b) Select the Condition attribute for
the Landscaping feature by
clicking on it once.

c) Click on the Edit Attribute button.
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d) Select the first attribute value,
Healthy.

e) Click on the Edit button.

f) Change Healthy to Grass.

g) Remove it as the Default option by
unchecking the Default box.

h) Click on OK.

9.  Review skills: Edit Attribute Values
a) Change the remaining

attribute values for
Landscaping to coincide with
those in Table 1 (Grass,
Natural, Cultivated and Bare
Ground).

b) You will need to choose the
New button to add the fourth
attribute value, Bare Ground.

c) When your attributes are the
same as shown here, click on
OK.



GPS Manual

32 UNH Cooperative Extension

10.  Add a Numeric Attribute

a) For the Urban Tree Feature, add the
Height attribute to your data dictionary.
Note that Height is a numeric attribute.

b) Select the numeric values shown here
when defining the Height attribute.

TIP: To avoid inconsistencies when collecting data, always include the units for numeric
attributes in the attribute name.  In this example, we named the attribute “Height(feet)”,
so that the data collectors know to record the width in feet and not meters.

c) Complete the data dictionary as described in Table 1.  Remember that copying and
editing existing attributes and features may save you time.

d) When complete, click on the Save
button in the Data Dictionary Editor
or select Save from the File menu.

e) Close the Data Dictionary Editor
window.
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11.  Download Data Dictionary to Data Logger
You will need to download the data dictionary to the data logger in order for it to be used
in the field.

TIP:  To import a data dictionary from your GIS, see Exercise 5.

a) Connect the data logger to your
computer. (See The Basics
chapter.)

TIP:  When your Data Logger software boots up, it automatically will try to connect to
GPS satellites.  It will say, “Connecting to GPS” in the lower right corner of the data
logger.  Press the <Esc> button on the Data Logger, and it will eventually stop trying to
connect to the GPS receiver.

b) Select File Manager from the Main
menu.

c) Select File transfer. The data logger
screen will read, “Connect cable to
PC”.

d) Return to your computer. In Pathfinder
Office, select Data Transfer from the
Utilities menu.

TIP:  If you did not
successfully complete
steps a-c, you will
receive the error
message shown here.
To solve this problem,
click on OK and recheck
steps a-c.
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e) Click on the Send tab
since we will be sending
the data dictionary from
the computer to the data
logger.

f) Click on the Add Button.

g) Select Data Dictionary.

h) From the c:\Pfdata\GPSWorkshop
folder, select YourName-
PublicWorks.ddf

i) Click on Open.

TIP:  If the data dictionary file is not
listed, check that the Source Directory
is pointing to the folder that contains
your project files.  You created this
folder in the Mission Planning Exercise,
step 1.

j) Click on Transfer All.
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k) You should get a message
that the transfer was
completed.  Click on Close.

l) If the transfer was
successful, the data logger
screen will read, “Data
dictionary read OK”.

m) Close the Data Transfer
dialogue box.

TIP:  If you were not able to transfer successfully, check that you only have one data
transfer window open.  Close any extra data transfer windows that may be open and try
transferring again.

12.  OPTIONAL: To see the Data Dictionary on the data logger:
If you are curious and want to check to see how your newly created data dictionary
appears on the data logger, you can complete the following steps:

a) If necessary, return to the main menu on the data logger by pressing <Esc>
repeatedly until you are back at the main menu.

b) From the Main menu, select Data Collection, <Enter>.

c) Select Create new file, <Enter>.

d) Note that the default data dictionary is YourName-Public Works.  To see the other
data dictionaries available, press on the right arrow.

e) Press <Enter> to accept the defaults.  (You may want to change the filename to
“test” so that you know you can delete this file later.)

f) Note that the start feature menu lists all the features you included in the data
dictionary.  In addition, you can choose generic point, line and area features.

g) To leave the data collection mode, press <Esc> on the data logger.

h) Confirm that you are exiting data collection by selecting Yes (F1 on the data logger
keypad.)
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 Exerc ise 3: Data Collection
1.  BEFORE You Go: Assemble the GPS

unit
You don’t want to find when you are out in the field
that you forgot a cable.  Assemble the unit before
you go.  UNH Cooperative Extension units are
color coded to help you connect the cables
correctly. See The Basics chapter for instruction on
assembling the unit.

2.  BEFORE You Go: Check the
Batteries

You should check the batteries for the GPS
receiver and for the data logger.  Note that even
new batteries will often not show a charge of 100%.
The batteries for the GPS receiver are more likely
to run down than the battery for the data logger and should be carefully monitored.  Note
that there is a spare set of batteries for the GPS receiver in the backpack, so you can
change batteries out in the field.  Make sure that you check the charge on the spare set
as well.

a) See The Basics chapter for instructions on checking and charging the batteries.

3.  BEFORE You Go: Check Data Logger Storage Space
The data logger has 1.781 MB of storage space available for your files and data
dictionaries.  Make sure that there is adequate space on the logger before you go out in
the field.  While still in the office you can download files onto your computer before you
delete them.  The storage space can be increased with the insertion of a PC card into
the data logger.

a) From main menu, select Data
Collection.
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b) Select Create new file.

c) The last item on the Create new file menu
tells you the amount of storage space is
available.

d) See The Basics chapter  for information on
deleting files.

4.  BEFORE You Go: Configure Critical Settings
Critical settings are those that will affect the quality of your GPS data.  YOU MUST
CHECK THE CRITICAL SETTINGS BEFORE YOU BEGIN COLLECTING DATA.

Trimble recommends the settings noted in this table to achieve accuracy of better than
50cm (RMS)+1ppm times the distance between the base station and the rover. The
base station collects data at a known point, so it can compare the GPS location with the
“true” location and provide a correction factor. For now, it is important to understand that
the settings of your “rover” are critical to controlling the quality of the data that you
collect.  In this step, we will set critical settings to values recommended by Trimble.

Setting Recommended Value Configuration menu entry
Position mode Overdet 3D or Manual 3D GPS rover options/Position filters
PDOP mask 6 or less GPS rover options/Position filters
SNR mask 6 or more GPS rover options/Position filters
Elevation mask 15 degree or more GPS rover options/Position filters

a) From the Main menu, select Configuration
then press <Enter>.

b) Select GPS rover options, <Enter>.

c) Select Logging Options.

d) Set the following GPS rover options:

i) Logging Options:

Point – 1s
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Line/Area – 3s
Not in feature: None
Velocity: None

ii) Confirm End Features – Yes

iii) Minimum positions - 50

iv) Carrier Mode – Off

v) Press <Esc> when finished.

TIP: Use the Help button on the data logger to learn about the various menu options

.

NOTE: The logging options are described below. (Most of this information was modified
from the Trimble Asset Surveyor Help pages.)

Logging intervals: Allows the intervals between the logging of feature positions to be
specified. As noted in Exercise 2, the default logging interval is set at 5 seconds
because many base stations log at 5 second intervals.  If you choose a logging interval
that is different than the logging interval of your base station then the corrections to your
data will result from interpolations rather than from actual measurements.  For most
natural resources applications this interpolation will not introduce significant error.  You
should be aware, however, that to obtain the most accurate data, you would set the
logging interval equal to the base station logging interval. The CORS website
(http://www.ngs.noaa.gov/CORS/) provides information about logging intervals for
CORS sites.

Point feature: The GPS receiver will try to log a position every second when this
parameter is set to 1s.  GRANIT data collection standards suggest setting this
parameter to 1s.  The Trimble default (and suggested) value is 5 s.  See the
previous paragraph for further explanation.

Line/Area feature: The logging interval for collecting line and area features
should depend on the speed at which the rover is moving and the complexity of
the feature you are trying to map.  A more complex feature will require a shorter
logging interval.  Start by using 3s and modify the interval as necessary.

Not in feature: The receiver can log positions even when you are not recording a
feature.  This parameter sets the time interval between logged GPS positions
when you are not logging a feature.  You do not need to log positions between
features, so leave this set to the default value, which is None.

Velocity: Logging of velocity records at the specified interval.  For most cases,
you do not need to log velocity records so leave this set at the default value,
which is None.

Confirm End features:  The data logger will ask you to confirm that you are finished
collecting position information.  It is advisable to set this to Yes so that you will know
when you have finished collecting data about a feature.
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Minimum positions:

A more precise point location can be obtained by averaging many points.  This
parameter sets the minimum number of points that need to be logged before a point
feature can be save without confirmation.  The data logger will omit a "cheerful” beep
when the minimum number of positions has been reached.  GRANIT GPS data
standards recommend that you collect 20 to 60 position for a point feature.

Carrier Mode:
Carrier mode enables the receiver to collect Carrier Phase data.  Carrier phase data are
for surveying purposes and require more elaborate processing requirements.  We shut
off the carrier mode since it is for surveyors’ needs.

e) Select Position Filters <Enter>

i) Position – Manual 3D

ii) Elevation – 15 degrees

iii) SNR – 6 or 8 (8 will give higher quality readings than 6)

iv) PDOP – 6 or 8 (6 will give higher quality readings than 8)

v) PDOP Switch – This number isn’t relevant when the position mode is
Manual 3D.

vi) Apply real-time – Auto

vii) RTK mode – This option is not relevant for these GPS receivers.

viii) Press <Menu> when finished.

NOTE:  Below is information to help you understand the relevance of these critical
settings.  (Most of this information was modified from the Trimble Asset Surveyor Help
pages.)

Position mode:
Position Mode controls the number of satellites the receiver uses to calculate the GPS
position.  The choices are:

Manual 3D – The receiver uses at least four satellites.  This setting usually yields
the most accurate GPS positions.

Auto 2D/3D – The receiver uses four or more satellites when it is able to, but
when the number of usable satellites falls to three, it will compute 2D positions
using the last known altitude.  This mode greatly affects the accuracy of the
position and is not recommended for most users collecting data for a GIS.

Manual 2D – The receiver will always use the best three satellites available, even
when there are more satellites available.  This mode is not recommended for most
users collecting data for a GIS.

Overdetermined 3D – The receiver will only log positions when there are at least
five satellites available.  This mode yields the most consistently accurate GPS
positions.

Elevation mask:
The elevation mask restricts the GPS receiver to use only satellites that are above a
certain angle relative to the horizon. Any satellites below this angle will not be used to
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record positions.  The rover’s elevation must always be set above the base station’s
elevation mask.  The default base station elevation mask is 10 degrees; the default
rover elevation mask is 15 degrees.

SNR mask:
The SNR (Signal to Noise Ratio) mask restricts the GPS receiver to using only satellites
with a relatively low signal to noise ratio.  A ratio above 20 is very good, and an SNR
ratio above 6.0 is satisfactory.

PDOP Mask:
PDOP (Position Dilution of Precision) is a unitless measure which indicates the satellite
geometry, that is, where the satellites are relative to one another.

PDOP less than or equal to 4 provides gives excellent positions
PDOP between 5 and 8 is acceptable.
PDOP greater than or equal to 9 is poor.

Apply real-time:
Setting the apply real time parameter to auto results in the logging of all GPS positions,
whether or not the real time correction data are available.  This setting provides the
greatest flexibility.

RTK mode:
RTK (real time kinematic) is only relevant, if you are working with a survey grade
receiver.  The Trimble Pathfinder Pro XR’s are not survey grade receivers.

IMPORTANT:  PLEASE DO NOT CHANGE OTHER DEFAULTS IN CONFIGURATION
(Exception: you may change the Coordinate System to correspond to the coordinate
system of the map you may be using.)

5.  Collecting Data

a) From the Main menu, select Data
Collection, <Enter>.
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b) Select Create new file.

c) File name: - Use the default file name provided by
the software.  This name is coded by the following
formula:

R MM DD HH x

R = Rover (The GPS receiver that is out in the
field collecting data is known as a “Rover” while
the GPS receiver that is collecting data at a known
point is referred to as a base station.)

MM = current month

DD = current day of the month

HH = current hour of the day

x = indicates increments within the hour (For example, a is the first file for the hour,
b is the second file, etc.)

In this example, R092304A indicates that the files was collected by a Rover on
September  23.  The 04 could refer to the 4:00 am hour or the 4:00 pm hour
depending on whether the data logger is set to a 12 or 24 hour clock.  The A
indicates that this is the first file during this hour.  The selection of a 12 or 24 hour
clock is made in the Configuration menu, under Time and Date.

NOTE: If the file hour looks odd, it may be indicating the hour according to Greenwich
Mean Time (GMT).  By default the GPS receiver uses GMT to determine the day and
hour when naming files.  Eastern Standard Time is GMT minus 5 hours.  Eastern
Daylight Savings Time is GMT minus 4 hours.

1st Sunday in April – last Saturday in October – Eastern Daylight Savings Time (GMT
minus 4 hours)
Last Sunday in October – 1st Saturday in April – Eastern Standard Time (GMT minus 5
hours)

TIP: You can specify that the local day and hour be used to name the files.  When you
create a new file within data collection, time will appear as a “soft key” (i.e., it will be one
of the menu items that appear on the bottom of the screen).  Select the time softkey (F1)
and choose local time.  To check that the data logger’s local time is set properly, go to
the main menu and select Configuration.  From the Configuration menu, select Time and
Date.  If necessary, correct the local time to adjust for changes related to daylight
savings time.
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d) Data dictionary –Select the data dictionary you downloaded in Exercise 2. If you
didn’t create and download your own data dictionary then select Generic.

TIP: Note the amount of memory available to store data.  If there is insufficient memory,
you will need to delete data files. See The Basics chapter.

e) Select <Enter> to go to the Start feature menu.

f) Select point, line, area, or a feature from the data
dictionary that corresponds to the feature that you
want to collect. Note that the symbols next to the
items in the data dictionary indicate if they are point,
line or area features.

g) <Enter> - You will immediately start recording positions if the PDOP and SNR
position filter requirements are met.  The unit beeps when it collects position fixes.
It also beeps when the PDOP or SNR position filters are no longer met, and it has
stopped collecting points.  The number of points you have recorded will appear on
the lower right corner of the screen.

h) When finished recording the feature, select <Enter>.

i) Select Yes if you want to save the feature you collected.

j) To collect additional features repeat steps e-i.  Note that you do not need to create a
new file for each feature you want to collect.  You may collect all of your features in
the same file.

k) To exit from Data Collection click on the <Esc> button.

l) Select Yes to confirm that you want to leave data collection.

TIP:  You don’t need to create a new data file for each new feature that you record.  You
can have many different features in a single data file.

TIP:  Pressing <Esc> while collecting a feature will abandon the feature (i.e., not save
the data you just collected for this feature). Pressing <Enter> while collecting a feature
will result in saving the data you collected for the feature.  In both cases, the data logger
will prompt you to confirm that you want to either abandon or save the feature.

6.  Field Data Collection Assignment.
Below is a list of suggested data collection practice activities.  Read the tips that follow
for suggestions when collecting data.

a) Collect at least one point feature that corresponds to a feature in your data
dictionary (e.g.,  urban trees, sign, bus stop).  Collect the attribute information
associated with that feature.
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b) Collect at least one line feature that corresponds to a feature in your data dictionary
(e.g., Pedestrian Way).  Collect the attribute information associated with that
feature.

c) Collect at least one area feature that corresponds to a feature in your data dictionary
(e.g., landscaping, parking lot).  Remember that when collecting an area feature, the
software will automatically connect your first and last positions. Collect the attribute
information associated with that feature.

d) Collect a line feature as you walk to a  nearby forested area.  Collect at least one
point feature under a tree canopy.

e) For fun, you can try “writing” your initials by collecting points as you walk a path that
spells out your initials.  Remember that to accurately collect curved features, you
need to collect points frequently along the curve.  If necessary, decrease the logging
interval for the line feature so that you can efficiently collect points along curves.

QUESTION:  How did the experience of collecting data under a forest canopy compare
with collecting data in the open?

TIP:  What do you do when you can’t get a signal?
i) The best way to avoid this situation is to create a mission plan (Exercise 1)

and plan your field time to correspond to the times when the greatest
number of satellites will be present.

ii) Do the shuffle! Move a few feet or even just lean a few inches in various
directions to eliminate obstacles that may be blocking the path between the
satellites and the antenna.  Be aware that the further you move, the greater
error you may add to the positional data the GPS receiver collects.

iii) Remember that there are no satellites over the North pole.  Position the
GPS antenna to the south of obstructions so that they don’t block satellite
signals.

iv) If you are willing to accept poorer quality data, you can raise the PDOP
mask or lower the Signal to Noise Ratio (SNR).  According to Trimble, you
should first try to raise the PDOP mask first.  Do not lower the elevation
mask because it may cause you problems when you try to apply differential
corrections to your data.

TIP:  How can you collect an area feature with straight edges?

If you know that an area feature has straight edges, you can collect data just at the
corners and the software will draw straight lines to connect your corner positions.  To do
this:

i) Start an area feature and collect a position for a corner.

ii) Press the Pause key (F1).

iii) Walk to the next corner.

iv) Press the Resume key (F1).

v) Collect the position for this corner and press the Pause key (F1).

vi) Continue in this manner until you are at the last corner.  The software, when
collecting an area feature, will automatically connect your first and last
positions.
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7.  OPTIONAL: Saving a Nested Feature
While collecting line or area data you can temporarily stop collecting the line or area and
collect a point.  For example, if you are mapping trails, you may want to collect the
location of a feature of interest or an interpretive sign.  You can “nest” this feature and
then resume collecting the trail data.

a) While collecting the line or area feature select nest (F3) from the bottom menu.  If
you don’t see nest as an option, click on the right arrow (F5) to view additional menu
items.  You must be in the data collection menu to see these options.

b) Select Point_generic or another point feature from your data dictionary, press
<Enter>.

c) Record any attribute information you wish to record while the point data are being
collected.

d) Press <Enter> when you are finished recording points and confirm that you want to
store the feature.

e) The data logger will automatically resume collecting data for the feature you were
recording before you nested the point.

8.  OPTIONAL: Checking coordinates
You can check the coordinates and other characteristics of features you have collected.

a) From the data logger’s Main menu, select Data Collection.

b) Select Open existing file.

c) Use the right arrow key to see a menu of files that are currently in the data logger.

d) Scroll down the list using the arrow keys to select the file of interest.  Press
<Enter>.

e) Note that the screen now gives you information about the file size, time, date, etc.

f) Press <Enter> again to review the contents of the file.

g) Select one of the features in the file using the arrow keys.

h) To view the position information, select Pos (F2) from the bottom menu.  If you don’t
see Pos as a menu option, select the F5 to view additional menu options.

i) Depending on the feature type, you may need to indicate if you want to see, for
example, the beginning of the line or the end of the line.  Select your option and
press <Enter>.

j) You can now see the coordinates for the feature.  Please note that the type of
coordinates depends on the datum that was used.

9.  OPTIONAL: Skyplots
You can see a map of the satellites while you are collecting data.

a) From the data logger’s Main menu, select Satellite Information.
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b) The map will show you the satellites the GPS receiver is currently tracking.

c) Press Mode (F1) to see a chart of the signal to noise (SNR) ratio for each satellite
that the receiver is tracking.  Note that there is a line on the graph that indicates the
SNR filter you defined.  Satellites with a SNR less than your designated filter, are
will available to contribute data to any features you collect until their SNR meets
your requirements.

d) Press Mode (F1) to see a table of the satellites being tracked, their SNR, Elevation
and Bearing (BR).

10.  OPTIONAL: Offsets
You may want to collect the position of a feature without actually having the GPS
antenna at that feature.  For example, you may want to record the centerline of a road,
but you don’t want to walk or drive down the middle of the road.  Alternatively, a large
obstruction such as a cliff or building may block satellite signals, making data collection
difficult or impossible. You can still collect positions for features under these
circumstances by standing away from the feature and defining the offset from your
position to the feature.

There are two formats you may use to define your offset.  You may define the slope
distance and inclination or you may define the vertical and horizontal distances between
the GPS position and the feature position. Below are illustrations and explanations of
these formats (from Trimble’s Help pages).

Bearing
The bearing is the angle between North and a line from the observer to the feature. The
field name contains (T) or (M), depending on whether North is true or magnetic.

Slope Distance
The slope distance is the length of a straight line from the observer to the feature.

Inclination
The inclination is the angle between a horizontal line and a line from the observer to the
feature. When the feature is higher than the observer, the inclination is positive.

Horizontal Distance
The horizontal distance is the length of a horizontal line from the observer to a vertical
line through the feature.

Vertical Distance
The vertical distance is the distance from the feature to a horizontal line from the
observer. When the feature is higher than the observer, the vertical distance is positive.

Direction
The direction indicates whether the feature is to the left or to the right, looking along the
direction of collection.
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In this example, we will define the offset using the vertical and horizontal distance.

To create an offset for a line feature:
a) In Data Collection mode, start a new line feature and press <Enter>.

b) Select offset from the soft keys.  You will need to first select F5 to see the second
set of softkey options, then select F3 for offset.

c) Select the format that requires direction, horizontal distance and vertical distance by
pressing F2 until this format appears.

d) To choose direction, press the right arrow (from the circular disk) and select left or
right.  Remember the left or right is relative the direction you are traveling when
collecting the line.

e) Type in the appropriate horizontal and vertical distances.  Note the units when
inputting the distances.  You will create errors if you input the distances in feet and
the unit indicates that it is expecting the distances in meters.

TIP: To change the distance units, press the Menu button.  From the main menu, select
Configuration.  Select Units and display.  At the distance option, press the right arrow
and select the units of your choice.  Press <Enter> to choose the units and then press
<Enter> again to actually make the change.  (If you forget to press <Enter> the second
time, the desired change will not take place when you are in data collection mode.)
Press the Next button to return to data collection.

TIP:  You can also set or change offsets in Pathfinder Office. Open the GPS file in
Pathfinder Office and select the feature of interest in the map window.  From the Data
menu select Feature Properties.  Click on Offset in the Feature Properties window and
you will have the option to change the offset parameters.

11.  OPTIONAL: Background maps
You can also view maps of the data you collect or data you download from a GIS (see
Exercise 5).

a) From the data logger’s Main menu, select Map, press <Enter>.

b) Press Options (F2) from the bottom menu.  (If Options is not available, press F5 to
see additional menu items.)

c) Note the items you may choose to Show or Hide.

d) Use the arrow keys to scroll to Background file at the bottom of the list. Use the
right arrow key to select a file to use as background for your map.
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 Exerc ise 4: Data Correction and
Export

Correcting the data collected with your “rover” with information collected from a base
station is critical to obtaining more accurate data, especially if your data were not
corrected in “real time” (i.e., with base station data transferred by a beacon or satellite
service).  If your data have “real time” corrections you may not want post process as this
could possibly add errors to your corrected data.  In this exercise, we will show you how
to post process your data and export into an ArcView Shapefile format.

1.  Downloading from the GPS
a) Connect the data logger to your computer (see

The Basics chapter).

b) From the GPS data logger Main menu, select File
Manager.

TIP:  When the data logger software boots up, it
automatically will try to connect to GPS satellites.  It will
say, “Connecting to GPS” in the lower right corner of the
data logger.  Press the escape button on the Data Logger,
and it will eventually stop trying to connect to the GPS
receiver.

c) Select File Transfer.

d) Leave the data logger on the screen that says, “Connect cable to PC”.

e) Return to the Pathfinder Office software on your computer.

f) Select the Data Transfer tool, or from the Utilities menu, select
Data Transfer.

Data Transfer
Tool
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g) Select the Receive tab.

h) Click the Add button.

i) Select Data File.

j) Select the file(s) you want to
transfer.  Hold down the
control key while clicking on
the file names to select more
than one file at a time.

k) Click on Open.

l) Click on Transfer All.

m) Close the Transfer Completed notice.

n) Close the data transfer window.
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2.  Set the Coordinate System
To avoid, problems, it is helpful if you immediately set the coordinate system for your
data.

a) From the Options menu, select
Coordinate System.

b) Set the coordinate system so that it is
the same coordinate system that
GRANIT data are in:

System: US State Plane 1983
Zone: New Hampshire
Altitude Measured From: Mean Sea Level

Defined Geoid
Coordinate Units: US Survey Feet
Altitude Units: US Survey Feet

c) After double checking that all the
parameters are set correctly, click on
OK.

NOTE:  For more information about coordinate systems and GRANIT’s geodetic control,
see the Geodesy Notes in the Appendix.

3.  OPTIONAL: View your data in Pathfinder Office
It can be useful to look at your data in Pathfinder Office before exporting it to a GIS.
Pathfinder Office allows you to view your data, combine it with other data and print a
map.  It has fewer display options than a GIS program, but it’s mapping abilities may be
adequate for some needs.

a) From the View menu, select Map.
(If there is a check next to Map
in the View menu, then your map
window is already open.)

b) From the File menu, select Open.

c) Select your GPS rover file and
click Open.

TIP: To help identify your files
remember that the files are coded as
follows:
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R MM DD HH x

R = Rover
MM = current month
DD = current day of the month
HH = current hour of the day
x = indicates increments within the hour (For example, a is the first file for the hour,
b is the second file, etc.)

4.  OPTIONAL: Add a background image
You can bring in data from your GIS to display as background to your GPS data.

a) From the File menu, select
Background.

b) Click on the Add button.

NOTE:  There may be background files already loaded from a previous Pathfinder Office
session.  You may ignore these files or you can remove them.  Removing them does not
delete the file from the disk.  It only removes them from this list.  You can access them
again with the Add button.

c) Navigate to the c:\GPSWorkshop \
*Photo folder.  Select the file within
the *Photo folder.  (The exact name
of this folder will vary according to
the workshop location – ask the
instructor for assistance.)

d) Click on Open.
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e) Note that Pathfinder Office will remind you that the coordinate system of your
background file needs to be the same as the coordinate system of your map
window.  We set the coordinate system of the map window in step 2.

f) Double check that the
coordinate system of the
background file is the same as
the coordinate system shown
here.  If it is not the same, click
on the Change button and set it
correctly.  See step 2 for details
on setting the coordinate
system.

g) Click on OK.

5.  OPTIONAL: Change the symbols
You can change how the features appear on
your map.  You can change point symbols,
colors, and line thicknesses.

a) To change how your data are “symbolized”,
from the View menu select Layers and then
select Features.

b) Double click on a point feature to change its
symbol.



GPS Manual

54 UNH Cooperative Extension

c) Select a new symbol and click on OK.

d) Double click on a new area or line
feature.

e) Select a color and thickness.

f) Click on OK.

TIP: Uncheck the Join box if you want unconnected dots to represent your logged GPS
positions.
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6.  Correcting the Data
You may not need to apply differential correction to data that were corrected in real time.
(The data logger for the Trimble Pro XR will display a radio beacon icon on the lower left
corner of the display panel, if you are getting real time corrections.) In fact, depending
on the quality of the base station data, you may introduce inaccuracies into data by post-
correcting data that were already corrected in real time.  In this exercise, we will show
you how to correct only the data that were not corrected in real
time.

a) Click on the Differential Correction tool or select
Differential Correction from the Utilities menu.

b) Click on Settings.

c) Click on the Code
Processing tab.

Differential Correction
Tool
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d) Note that the default is to Correct Realtime DGPS Positions.  In theory, you can
improve the accuracy of your GPS data by post-processing data that were already
corrected in real time.  In practice, we have found that post-processing real time
corrected data can sometimes produce suspicious results.  If you are happy with the
accuracy of your real time corrected data, you may want to uncheck this box so that
you only correct data that were not corrected in real time.  If most of your data were
real time corrected, you probably won’t see a significant difference when post
processing.

e) Click on Internet Search.

f) Click on the New button to
download the most recent list of
websites that provide base station
data.

g) Select the option to Copy the most up-
to-date list from Trimble’s Internet site.
Pathfinder Office will now go to Trimble’s
web site and down a list of base station
data providers.
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TIP: If you get a Confirm Internet
Setup warning, click on Yes to
continue.  This warning appears to
be a result of computer security
issues.  It will not affect your ability
to correct the data. Select the
internet site closest to you.

h) To sort the list of providers by
distance, click on the Distance
column header.

i) Select one of the closest sites.

TIP: The base station closest to you will generally give you the best corrections.  The
base station must be within 300 miles of your rover.

NOTE:  For more information about CORS (Continuously Operating Reference Station)
sites, see http://www.ngs.noaa.gov/CORS/.

j) Click on the Properties button
and examine the information
provided for this base station
site.

k) Click on OK.
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TIP:  If you try to download base station data immediately after data collection, you may
find that the files are not yet available.  It may take an hour or so for the base station
data to be posted to the web site. If you wait too long, you may find that the data are no
longer available over the internet, and you will need to submit a special request to
retrieve them from the archives.  To be safe, you should process your files within a week
of collecting them.

TIP:  If you get a message that files have failed to transfer, you can try another internet
site.  If you are not successful at other sites and you suspect that your files may be old,
contact the site manager about retrieving data from the site’s archives.  The internet site
properties (step g) give you the manager contact information.

l) When Pathfinder Office prompts you to confirm the selected base files, check that
the percentage of coverage isn’t “None”.  If it is “None”, then you weren’t successful
and you need to  try a different base station provider.  If you do have coverage, then
click OK.
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m) Click on OK when it gives you the base station
reference position information.

n) Note that the corrected files will have a *.cor
extension.  Note also where the corrected files
will be saved.  If necessary, change the location
of the Output files by clicking on the Browse
button and navigating to your project folder.

o) Select Code Processing Only since we did not
collect Carrier Phase data.

p) Click on OK.

q) Read the information in the correction
completed window then close the window.

7.  OPTIONAL: View the corrected data with the uncorrected
data.

In order to see both the corrected and uncorrected data together, you can add the
corrected data as background to your map.

a) From the File menu, select Background.

b) Click on Add.

c) Navigate to your project folder. C”\Pfdata\GPSWorkshop-<YourName>.

d) Select the corrected file.  Remember the corrected file has the *.cor extension.
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Click here to
show file details.TIP:  If you can’t see the file extensions,

click on the button indicated here to list
file details.  The corrected file will have
“Trimble corrected data” in the Type
column.  Alternatively, corrected files
have an icon that resembles a bullseye.

e) Click on Open.

f) Click on OK.

g) You can change the way the background features are symbolized the same way
that we changed the symbols for the GPS data in step 5.  From the View menu,
select Layers and then Background.  Review step 5 for further instruction.

h) Use the Zoom in tool
to zoom to a point
feature.

i) Use the measuring tool to measure the distance between the corrected and
uncorrected features.  With the measuring tool click on the uncorrected feature and
then click on the corrected feature.  (Double click to stop measuring.) The distance
between the two features will appear in the lower left corner of the map window. If
you can’t tell which point is corrected and which is uncorrected, remember that you
can always change the symbolization to differentiate them.

Measuring
tool

Zoom In
tool
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NOTE:  If you had real time corrections when you were collecting the data, you may find
very little difference between your corrected and uncorrected data.  Post-processing real
time corrected data generally does not result in dramatic differences in positions.

8.  Exporting to GIS
You can export your GPS data to use in other software
programs such as ArcView, ArcInfo, AutoCAD, MapInfo and
GRASS.  We will demonstrate how to export to ArcView.

a) From the Utilities menu, select Export or click on the
Export tool.

b) Make sure the Output Folder is correct.
For the workshop, it should be:
c:\Pfdata\GPSWorkshop\export

c) Choose Sample ArcView Shapefile
Setup.

Export
Tool
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d) IMPORTANT! Make sure that the GIS Coordinate System noted in the window is the
same as GIS coordinate system to which you will be exporting.  If the coordinate
system information shown here does not match your GIS, your GPS data will not
overlay correctly.   (This may not be an issue if you are using ArcGIS software which
can re-project data “on the fly.”  In this case, however, you should note the
coordinate system that your exported GPS data are in because you will need to
define it for the ArcGIS software.) The export system shown here is correct for NH
GRANIT data.  If it is not correct for your GIS data, see the TIP below.

e) Click on Properties.

f) Continue to step 9 to specify the
attributes to export.

TIP: To change the GIS coordinate
system:

i) Select Coordinate System
Tab.

ii) Select Export Coordinates As
XY.

iii) Click on the Change button
to select a different
coordinate system.

iv)  If you are using GRANIT GIS
data, select the coordinate
system as indicated here:

System: US State Plane 1983
Zone: New Hampshire
Altitude Measured From: Mean Sea Level

Defined Geoid
Coordinate Units: US Survey Feet
Altitude Units: US Survey Feet

v) Click OK in the Export window.

vi) Do not click OK in the Export
Setup window until you
define the attribute export
information in the next step
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9.  Export to GIS: Document your data
You should always document your data so users now and in the future are able to
interpret it appropriately.  In addition to the coordinate information (x,y and sometimes
z), you should include the following in the documentation:

• positional accuracy value for the coordinates
• when and where the data were collected
• by whom the positions were collected
• what equipment was used
• what software (including version) was used to

process the data
• whether post-processing corrections were

applied

You can include some of this information in your
export file.

a) Click on the Properties button in the Export
window.

b) In the Export setup window, select the
Attributes tab.

c) Select the option to Export Menu
Attributes As Attribute Value.

d) Click on the various precision
measurements shown here.  Note that
we did not include vertical precision
measurements because we are
interested in horizontal (x,y) data only.
You may want to include
measurements such as Area,
Perimeter and Length although we can
also calculate this information with our
GIS software.  Additional attributes (not
visible in the figure) to include under
the “All Feature Types” category are:
Feature Name, Total Positions, Data
Dictionary Name

TIP: Click the Help button and read the
description of the various attributes that are
available for export.
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TIP: If you are in doubt about whether to include a particular attribute, it is easier to
simply include the attribute now and remove it later if you don’t need it.

e) Once you have completed your selection of attributes to include in the export data,
click on OK in the Attributes window.

f) Click on OK in the Export Setup window.

g) Use My Computer or Windows explorer to check that export files (ArcView
shapefiles) were written to the folder: c:\Pfdata\GPSWorkshop\export

h) These shapefiles can now be brought into ArcView and combined with other GIS
data.

TIP: If you want to export uncorrected data, you should double check the Position Filters
in the Export Setup Properties to make sure that they don’t exclude uncorrected points.
Remember that even if you omit the post collection data correction steps described in
this exercise, your data are considered corrected if you had “real-time” corrections, that
is, the GPS receiver was receiving a Coast Guard beacon signal while you were
collecting the points.  Note that if you are unsure of the correction status, the attribute
table of the exported data will have the correction status of positions if you selected
Correction Status as one of the attributes to include in the exported data.  (See Step 9.)

10.  Rename your GPS export files
When you export your GPS data using Pathfinder Office, the software automatically
names the exported shapefiles the same name as the feature.  For example, if your
feature was collected as a Point Generic, it will name the exported shapefiles
point_gen.shp, point_gen.shx, point_gen.dbf.  There are two potential problems with
this: one, the file names aren’t necessarily useful for remembering and archiving your
data and two, the next time you export a Generic Point, you risk overwriting your data.
We highly recommend that you take the time to rename your shapefiles to something
useful.  Remember to rename all three files associated with the shapefile to the same
name, but don’t change the file extension.  ArcView will needs to know the exact file

This box needs to be
checked if you want to
export uncorrected
data.
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extensions.  For example, these three point generic files could be renamed:
BusStopsasof092303.shp, BusStopsasof092303.shx, BusStopsasof092303.dbf  NEVER
use spaces or odd characters in shapefile names!  You will eventually run into serious
problems if you use shapefiles with spaces or unusual characters in the file name.

11.  Stay Organized
Keeping your GPS and GIS data organized is challenging but very important.  Now that
you have created shapefiles for use with your GIS, take a moment to copy your new
shapefiles to a clearly labeled folder where you keep your GIS folder.  You may also
want to consider creating a metadata file that documents your GPS data so that it can
be used effectively by you and others in the future.  Contact the GRANIT Project at
UNH’s Complex Systems Research Center for information on metadata standards
(www.granit.sr.unh.edu).
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 Exerc ise 5: Bringing GIS data into
your GPS unit

You can import information from a GIS to your GPS unit.  You may want to import
mapped features to use as background when checking the location of your points.
Alternatively, when updating or adding to existing GIS data, you can import the data
dictionary from your GIS database.  Data can be imported in the following formats:
• ArcView Shapefile
• dBASE
• MapInfo MIF

In this exercise, we will import the data dictionary and features from an ArcView
shapefile (Durham roads).  Note that we will not complete this exercise during the GPS
for GIS workshop; it is provided here for your convenience.

1.  Import Features and Data Dictionary from GIS

a) From the Utilities menu, select Import or click on the Import tool.

b) Click on the Browse button.

Import
tool
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c) Navigate to the folder:

C:\GPSforGIS\DurhamRoads

d) Select the file roadsdur.shp.

e) Click on Open.

f) Click on Properties.

g) Select the Data tab.

h) Select Features with Data Dictionary as
the Type of Data to Import.
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2.  Set the Coordinate Systems
a) Select the Coordinate System tab.

b) Click on the Change Settings button.

c) To correspond to GRANIT
data, change the System to US
State Plane 1983.

d) Change the Zone to New
Hampshire 2800.

e) Select Mean Sea Level.

f) Select Defined Geoid (GEOID
96[Conus])

g) Change the Coordinate Units
to US Survey Feet.

h) Change the Altitude Units to
US Survey Feet.

i) After checking that you set the
coordinate system correctly,
click on OK.

NOTE:  If you are working with data from sources other than GRANIT, the coordinate
system may be different.
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j) Click on the OK in the Import Utility window.

k) You will receive confirmation that the import
was completed. Close this confirmation
window.

l) You can use My Computer or Windows Explorer to look in the
C:\PfData\GPSWorkshop folder where you will find a file with a *.imp extension.
This is the file you just imported.

3.  Edit the data dictionary
The data dictionary we brought in from our GIS will require editing before we use it in the
field.  We are only interested in collecting attribute information related to the road class
attribute, so we will delete the other attributes using the data dictionary editor.

a) From the Utility menu, select
Data Dictionary Editor, or click
on the Data Dictionary Editor tool.

b) Select Import from Data File
from the File menu in the Data
Dictionary Editor.

c) Locate the *.imp file that you just
imported from the GIS data.
(Please note that you may not
have as many files in your folder
as shown in this figure.)

d) Click on Open.

e) Note that all the attributes from the
GIS file have been brought into the
data dictionary.

f) Select the attribute FNODE_ by
single clicking on it.

g) Click on the Delete Attribute button.
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h) Repeat steps f-g and delete all of the
attributes except Class.

TIP: F9 is the shortcut key to delete
attributes.

i) When you are finished, your data
dictionary should look like the one
shown here.

j) Select the Class attribute and click on
the Edit Attribute button.

k) Note that the existing minimum and
maximum values in the GIS file
define the Minimum and Maximum
values shown in the data dictionary.
In the case of the Class attribute,
they are correct, but in other
instances you may want to edit these
values.

l) Click on OK.

m) Save the edited data dictionary by
selecting Save As from the File menu.

n) Make sure that you are in the
C:\Pfdata\GPSWorkshop folder.

o) Name the file ImportedRoads.ddf.

p) Click on the Save button.
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4.  Download the data dictionary onto the data logger
To use the data dictionary we imported from our GIS data, we will need to download it
onto the GPS data logger.

a) Follow step 10 in Exercise 2 to
download the data dictionary onto the
data logger.

b) Note that the data dictionary imported
into the data logger will have the name
“Generated by Import”. The data
dictionary file on your computer will still
have the name you assigned,
ImportedRoads.ddf.  You can now use
this data dictionary when collecting
data.

5.  OPTIONAL: Download the feature map onto the data logger
You will need to download the data dictionary to the data logger in order for it to be used
in the field.

a) Connect the data logger to your
computer.

TIP:  When your Data Logger software boots up, it automatically will try to connect to
GPS satellites.  It will say, “Connecting to GPS” in the lower right corner of the data
logger.  Press the <Esc> button on the Data Logger until it stops trying to connect to the
GPS receiver.

b) Select File Manager from the Main
menu.

c) Select File transfer. The data logger
screen will read, “Connect cable to
PC”.
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d) Return to your computer. In Pathfinder Office, select Data Transfer from the
Utilities menu.

TIP:  If you did not
successfully complete
steps a-c, you will
receive the error
message shown here.
To solve this problem, click on OK and recheck steps a-c.

e) Click on the Send tab
since we will be sending
the GIS data from the
computer to the data
logger.

f) Click on the Add Button.

g) Select Data File.

h) From the c:\Pfdata\GPSWorkshop
folder, select the import file you
created (*.imp).

i) Click on Open.

TIP:  If the data file is not listed, check
that the Source Directory is pointing to
the folder that contains your project files.
You created this folder in the Mission
Planning Exercise, step 1.
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j) Click on Transfer All.

k) You should get a message that the
transfer was completed.  Click on
Close.

l) Close the Data Transfer window.

m) The message “File received” will
appear on the data logger screen.

6.  OPTIONAL: View the imported map on the data logger
a) From the data logger Main menu, select Map.

b) Look at the bottom menu to find the Options function.  If you do not see it, press F5
to see additional menu choices. Use the arrow key to scroll down to Background
file.

c) Select the file that you just imported.

d) Use the arrow keys and Zoom In/Zoom out (function keys) to navigate around the
map.
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Geodesy Notes for GPS and GIS
Applications
Geodesy (j‘-od’c-s‘) – The science dealing with the determination and
representation of the shape, area, and curvature of the earth. (from the Greek:
ge (earth) + daiein (to divide)

Who cares about geodesy?
Life may have been simpler when we thought the Earth was flat, but our maps
weren’t very accurate. It is generally necessary to be able to estimate the size
and shape of the Earth to accurately map features on the Earth’s surface.  For
this reason, the science of geodesy has developed increasingly accurate
methods of calculating the Earth’s size and shape. While you don’t need to
understand the details of the calculations in order to use GIS or GPS
technologies, it is helpful to know a few basic concepts and the geodetic
characteristics of your data in order to avoid errors and frustrations.

Overview:
Scientists have been approximating the shape of the earth for many centuries.  As we
know, the earliest concept of the earth’s shape was that of a sphere.  This notion,
reached in the 6th century BC, was based largely on celestial observations, and
particularly on observations of the lunar eclipse.

However, by the end of the 1600’s, it was generally accepted that the Earth was
shaped like an ellipsoid, not a sphere.  (An ellipsoid is simply an ellipse rotated
on its shorter axis.) This notion of an imperfectly shaped earth was based on the
work of Newton and others, who determined that the earth spinning on its axis
would produce bulging at the center and flattening at the poles.

Over time, geodesists have figured out that the Earth is actually shaped like a
lumpy potato, that is, its shape is irregular. This representation of the Earth’s
shape is referred to as the geoid.  The notion of an irregular shape is not a
reference to topographic influences, such as mountains and valleys.  In fact,
these topographic variations are considered trivial in the overall calculation of
the geoid.  Rather, the irregular shape takes into account variations in the
density of the earth’s crust which lead to varying gravitational pulls. The geoid is
a very irregular shape compared to an ellipsoid.

Mathematically it is impractical to define the geoid, so an ellipsoid is used as an
approximation for most mapping applications.  The size and shape of the
ellipsoid used to approximate the Earth’s shape varies depending on what area
of the Earth is of interest.  Note that an ellipsoid which approximates one area of
the Earth may not adequately represent another area (Fig. 1).  (Note also that
the term spheroid, which is an ellipse that approximates a sphere, is sometimes
used when referring to the Earth’s ellipsoid.)



Figure 1:  The Geoid and Two Ellipsoids
An ellipsoid is used to approximate the shape of the geoid which is shown in grey.  Different
ellipsoids are used for different areas of the Earth.  In this figure the ellipsoid, labeled A, fits the
geoid very well for N. America but does not fit well for the other continents shown in the figure.

Modified from Defense Mapping School 1997.

A

A datum (sometimes referred to as a geodetic datum) is a reference model of
the Earth which is designed to best fit the geoid.  Datums are defined by the size
and shape of the ellipsoid and its location relative to the center of the Earth or
relative to a point on the surface of the Earth.  Different datums are used to
describe the different areas of the Earth.

NH GRANIT data are based on NAD-83 (North American Datum – 1983), which
incorporates the GRS-80 ellipsoid (Geodetic Reference System - 1980). GPS
coordinates are normally based on the WGS-84 (World Geodetic System 1984)
datum which incorporates an ellipsoid that is almost identical to the GRS-80
ellipsoid.  NAD-83 and WGS-84, for all practical purposes, are equivalent.
Another commonly used datum, NAD-27, incorporates the Clarke 1866 ellipsoid.
GIS data based on two different datums will not overlay properly and will result
in errors in your GIS maps and analyses.

Map projections are the mathematical formulas used to convert locations from
a three dimensional sphere to a two dimensional map.  Representing an area of
the three-dimensional Earth on a two-dimensional map results in distortion.  One
or more of the following qualities will always be distorted on a map: area,
distance, direction, shape or proximity.  The type of projection that is used (and
hence which qualities are preserved and which are compromised) depends on
the intended map use.  The degree of the distortion will depend on the map
scale, with smaller scale maps having more distortion than larger scale maps.
GRANIT data are projected using the Transverse Mercator projection. TM is a



conformal projection, meaning that it shows the shapes of small features
correctly although some distortion may exist for larger features.  (For a more
detailed discussion of map projections, see Theobald (2000).)

In addition to knowing the datum and projection that your data are based on, it is
important to know their coordinate system.   Coordinate systems allow map
users to identify specific locations on the Earth. Latitude and longitude, also
referred to as decimal degrees, are spherical coordinates used to identify a
point on the Earth.  It is difficult to calculate distance and area with a spherical
coordinate system because it requires spherical geometry.  For this reason,
planar or two-dimensional coordinate systems are often used. The coordinate
system for GRANIT data is NH State Plane.  The units are US Survey Feet.
Figure 2 shows the NH State Plane coordinate system and its origin.  Note that
the origin is intentionally placed well outside of the state boundaries, in order to
ensure that all coordinates values will be positive.

Figure 2.  NH State Plane Coordinate Grid.

It is critical that the data layers be based on the same datum, projection,
coordinate system and units when combining data in a GIS.  Table 1
summarizes GRANIT’s geodetic control characteristics.  Be aware that when
combining GRANIT data with data from other sources, the geodetic control
characteristics should be the same.

Table 1: Summary of GRANIT Geodetic Control
Datum: NAD-83
Ellipsoid (Spheroid): GRS-80
Projection: Transverse Mercator
Coordinate System: NH State Plane (Zone 4676)
Units: US Survey Feet



Tools and Tips to Address Geodetic Issues:
Below are some tools and tips to address geodetic issues that you may
encounter:
 ArcView GIS version 3.3 has an extension, the “Projection Utility Wizard”,

that allows you to convert projections and datums.
 Additional ArcView scripts and extensions are available at

http://arcscripts.esri.com/. Use the “Search by category” option and select:
ArcView Views: Projections and Extents

 When using data that are already projected in ArcView, you do not need to
set a projection.  Setting a projection will distort the data.   If your data are
not projected, that is, they are in decimal degrees, then you can select a
projection using the Projection button in ArcView’s View Properties dialog
box.  Do not put projected data into the same View as unprojected data.

 You can export GPS data from Pathfinder Office, the software that is used
to process the data collected with Trimble GPS units, so that they are
referenced to the same datum and coordinate system as the other data
layers in your GIS.

 The Geodetic Tool Kit, available at http://www.ngs.noaa.gov/TOOLS/,
includes software that converts coordinates, transforms datums, and more.

 Corpscon, available at
http://crunch.tec.army.mil/software/corpscon/corpscon.html, is a MS-
Windows-based program which allows the user to convert coordinates
between Geographic, State Plane and UTM systems on NAD 27, NAD83
and the High Accuracy Reference Networks (HARNs).
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Legal Definition of Land Surveying and
Restrictions on Practicing Surveying
RSA  310-A:54 Definitions. As used in this subdivision:

IV. Practice of land surveying means any service or work, the adequate
performance of which involves the application of special knowledge of the principles of
mathematics, the related physical and applied sciences and the relevant requirements of
law for adequate evidence to the act of measuring and locating lines, angles,
elevations, natural and man-made features in the air, on the surface of the earth,
within underground workings, and on the beds of bodies of water for the purpose
of determining areas and volumes, for the monumenting of property boundaries and for
the platting and layout of lands and subdivisions of land, including the topography,
alignment, and grades of streets and for the preparation and perpetuation of maps,
record plats, field note records and property descriptions that represent these surveys.

RSA 310-A:53 General Provisions:

II. Except as provided in RSA 310-A:74, it shall be a class B misdemeanor
for any person to practice or to offer to practice land surveying in this state, or to repre-
sent by verbal claim, sign, letterhead, card, or in any other way that such person is a
land surveyor or is able to perform land surveying services, unless the person holds a
license under this subdivision. Admission to practice land surveying shall be determined
upon the basis of individual personal qualification.





GPS Data Collection Standards

NH GRANIT Project
Complex Systems Research Center
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Introduction

New Hampshire GRANIT is a cooperative project to create, maintain, and make available a
statewide geographic data base serving the information needs of state, regional, and local
decision-makers.  Increasingly, GRANIT is using Global Position Systems (GPS) technology to
collect locational data and to provide ground truth information.  The purpose of this document is
to record the standards that GRANIT has developed for data collection and navigation using a
GPS.

Limitations
The standards documented herein were developed based upon the needs of GRANIT’s
projects, and they reflect the GPS units and software currently being used by project
staff.    They should not be assumed to apply to every project or every system, as
typically standards must be set based upon a project’s specific requirements.  For
example, there is no single standard with respect to where a user should stand while
collecting GPS data that is appropriate for all data collection needs.  In a historic
resources inventory, it may be appropriate for the user to stand at the front door of each
building, whereas for a land cover assessment, the user may aim for the center of a 30m
x 30m Landsat TM image pixel.  GRANIT strongly advises that users review this
document, and augment and/or modify it by developing specific standards to reflect the
specific type of data they are collecting and their anticipated usage of that data.

Hardware and Software

The GRANIT project uses Trimble Pro XRS systems with Asset Surveyor v. 5.10.
These are mapping grade units with the capacity to receive real time correction, and to
collect, store and transfer data.  Each unit also carries a subscription for satellite
differential service.  Pathfinder Office v. 2.70 is used to transfer data to and from GIS
applications and to post-process any points collected without real time correction.

Settings
Coordinate System and Units
All GRANIT data are referenced to the New Hampshire State Plane Coordinate System,
Zone 4676 (FIPSZONE 2800), and use the NAD 83 (North American Datum 1983)
geodetic control based on the WGS 84 spheroid.  Data transfer to and from the GPS
units is therefore easiest when the coordinate systems are set to US State Plane 1983,
New Hampshire zone, and the units recorded in US survey feet.



Data Collection and Navigation Parameter Settings
The standards used in the field vary, depending on whether the purpose is data collection
or navigation.  Data collection requires a higher level of accuracy than most navigation,
and therefore stricter standards are applied.  Navigation may require a very high level of
accuracy, such as when navigating to a specific point for ground truthing; however, less
stringent standards may be used when still far away from the point (>500 feet), or when
navigating back to a vehicle.  Therefore, some navigation standards are presented as a
range of values, and while settings may be relaxed in some situations to find more
satellites and generate more readings, they should be changed to the stricter standards as
the user approaches a waypoint.

GRANIT retains many of the default receiver settings, and several others do not apply to the
projects for which we typically use GPS.  The settings listed below are only those that we adjust.

DATA COLLECTION NAVIGATION
Logging Intervals GRANIT primarily collects point

features, for which the selected
interval is one per second.  For line
and polygon features, this selection
would depend upon the
straightness of the line and the
speed of travel.  Twenty to 60
static position fixes are needed
when collecting a point feature.

Not applicable.

Position Mode Manual 3-D Manual 3-D (although Auto 2D/3D
may be used if four satellites are not
available, and high accuracy is not
required)

Elevation Mask 15 Variable: 8 (less accurate) to 15
(more accurate)

Signal to Noise
Ratio (SNR) Mask

6 6

PDOP Mask 6 Variable: 6 (more accurate) to 10
(less accurate)

PDOP Switch 6 6
Real time
correction

Required for collection (set to
“wait for real-time”).  If it is
unavailable, data may be post-
processed using the differential
correction utility in pathfinder
office software and data
downloaded from a base station.1

Not required for coarse navigation
(set to “use uncorrected gps”).
However, for highly accurate
navigation to a waypoint, the user
can set it to “wait for real-time.”  If
real time correction is available, the
user should try to get within 10 feet
of the intended waypoint.  Without
real time correction, the user should
get within 20 feet.

1GRANIT staff presently utilizes base station data from the Vermont Agency of Transportation
Continuously Operating GPS Reference Station (CORS) ftp site because the download process is fully
automated.  See ftp://vcap.aot.state.vt.us/ssf, or for general information, see http://vcap.aot.state.vt.us
Similar data is available from other base stations, including the NH Department of Transportation, but may
require more user intervention to utilize.



List of GPS Manufacturers
The following information was collected by the U.S. Coast Guard Navigation Center and
is offered with no claims of accuracy or completeness. The list is available on the web
at: http://www.mitre.org/technology/cots/GPS_MAN.html

Manufacturer Name Web Address or Phone
3S Navigation www.3snavigation.com
Allen Osburne Associates www.aoa-gps.com
Apelco Marine Electronics
(now Raytheon Marine)

www.apelco.com/products/year2000.html
1-603-881-9605

Arbiter Systems, Inc. www.arbiter.com
Ashtech, Inc. www.ashtech.com
Austron, Inc. www.austron.com
Azimuth Ltd. www.azimuth.co.il
Ball Efratom Division 1-714-770-5000
Bancomm-Timing Division of Datum,
Inc.

www.datum.com

Bendix/King 1-913-782-0400
Canadian Marconi Company www.mtl.marconi.ca
Centennial Technologies www.cent-tech.com
Commercial Equipment 1-714-833-4600
Corvallis Microtechnology Inc. www.cmtinc.com
Datum, Inc www.datum.com
Del Norte Technology, Inc. 1-817-267-3541
Eagle Electronics www.eagle-electronics.com
Furuno Electric Co., Ltd. www.furuno.com
Furuno USA, Inc www.furuno.com
Garmin Corp. www.garmin.com
Geotronics of North America Inc. 1-630-285-1400
Honeywell 1-612-957-4010
hopf Elektronik GmbH www.hopf-time.com
II Morrow Inc. www.iimorrow.com
Interphase Technologies 1-408-477-4944
Interstate Electronics Corp. 1-714-758-00500
ITT Avionics 1-973-284-3094
Japan Radio Co. Ltd (Japan) www.jrc.co.jp
Japan Radio Co. Ltd (USA) www.jrcc.com
JcAir www.jcair.com
Leica AG (Switzerland) +41-71-70-33-84
Leica Navigation and Positional
Division (California)

1-310-791-5300

Leica, Inc (Georgia) www.leica-gps.com
Lowrance Electronics, Inc. 1-918-437-6881
Magellan Corporation http://www.magellangps.com

1-800-669-4477
Marinetex 1-408-441-1661
Micrologic Systems, Inc. http://www.micrologic.com.ph

1-818-998-1216
1-632-631-4820

Motorola GPS Products www.mot.com/ACCES/GPS/products/gps
prod.html



NavStar Systems Ltd. +44-1-604-585-588
NavSymm Positioning Systems 1-800-486-6338
Northstar Technologies www.northstarmc.com
NovAtel Communications Ltd www.novatel.com
Odetics, Inc. 1-714-785-0400
Omnistar www.omnistar.com
Philips Navigation A/S +45-32-883626
Premier GPS Inc 1-403-295-8879
Pulsearch Navigation Systems Inc. 1-403-720-0277
Raytheon Marine www.raymarine.com
SCI Systems, Inc. 1-205-882-4800
Sercel Incorporated-USA 1-713-492-6688
Sercel-France +33 40-30-19-48
SiRF Technology www.sirf.com
SI-TEX Marine Electronics Inc. www.si-tex.com
Sokkia Corporation 1-913-492-4900 x155
Sony Corp. of America www.sel.sony.com
Spectrum Geophysical Instruments www.spintime.com
Stanford Telecommunications 1-408-745-0818
Starlink Inc. 1-512-454-5511
Telecom Solutions 1-408-433-0910
Topcon America Corp. 1-201261-9450
Topcon Europe +31-10-4-58-50-77
Trak Systems Division 1-813-884-1411
Trimble Navigation Ltd www.trimble.com
True Time, Inc                                1- 707-528-1230
Universal Avionics Systems Corp. www.uasc.com



CORS base station data coverage - Northeast
The National Geodetic Survey (NGS), an office of NOAA's National Ocean Service,
coordinates a network of continuously operating reference stations (CORS) that provide
Global Positioning System (GPS)  base station data to use for correcting rover  GPS
data.  Note on the map that the Vermont CORS site collects data at one second
intervals while most other CORS sites in this region collect data at 30 second intervals.
This map is available on the web at: http://www.ngs.noaa.gov/CORS/


